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This guide provides basic information
to enable you to install and run the current
release of boujou.
About This Guide
The typographical conventions used in this book are:

Convention

Description

This type

Menus, commands, buttons, and options displayed in the GUI.
Terms in a definition list or important words in a paragraph.

This type

Text displayed by the system or extracts of program code.

This type

Path names, file names, and extensions.
Commands or text you enter.

This type

Cross-references to related information in another section or
document, or to a URL.

Important.
Tip.

Information that emphasizes or supplements important points
or that may apply only in special cases.
Information on applying the techniques and procedures in the text
to your specific use, or an alternative method.
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Related Documentation
This guide is designed to be used in conjunction with
the additional documentation for this release of boujou,
shown in the following table.
Document

Description

Books

The boujou books are installed in PDF format (requires Adobe
Reader version 5.0 or later, which you can download free from
the Adobe Web site at www.adobe.com).

Tutorials

This book provides step-by-step instructions on performing
specific tasks using boujou.

Reference Guide

This book describes the features and functionality available in
boujou 4.1. Much of this information applies to the current release
of boujou. However, there are some differences in the interface and
functionality. Where there are differences, please see the relevant
documentation.

Vicon Web site

The Vicon online support system provides a library of information
that you can use to help answer your questions (for details, see
Chapter 5 Support Resources).
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About This Release
boujou 5.0 is the latest generation of Vicon’s
award-winning camera-tracking software. It
provides fully automated 3D camera tracking
and calibration from film and video material.
In most cases no prior information about
the camera or material is required, and no
skilled user intervention is needed to derive
the 3D information.
boujou makes it easier to add 3D objects to live
camera footage in your 3D animation package
by creating a virtual camera that matches the
physical one that took the shot. It does this by
automatically identifying features in the scene
over the entire length of the shot. These features
are automatically linked together into a large
number of tracks. boujou then uses state-ofthe-art techniques to solve the highly complex
3D mathematics in order to work out the camera
parameters for each frame of the shot.
Important. Some details of the software,
including the installation process, may have
changed slightly since this book was printed.
For up-to-date information, see the readme
file that came with your software.

New Features and
Enhancements
This section briefly describes the new features
and enhancements introduced in boujou 5.0:
•
•
•
•
•
•
•
•

Sequential Camera Solver on page 10
Graph Editor on page 10
Reference Frames on page 10
Target Tracker on page 11
Advanced Solve Adjust on page 11
Labeling Tracks on page 11
New Instant Zoom Tool on page 11
Software Licensing on page 12

More details on the new features are available
in the accompanying documentation.
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Sequential Camera Solver
Stepped solving
You now have far greater control over the way
boujou calculates the camera motion after feature
tracking is finished. Instead of having to wait until
the entire shot is solved, you can step through
the sequence, solving one frame after the other,
either forward or backward, making any changes
necessary during the solve process.

Choose the frames to solve
You can choose whether boujou calculates the
camera position for a range of frames, a single
frame at a time, or the entire sequence.
You can solve different sections of a sequence
independently.

Interrupt and restart solving
You can interrupt, make changes, and then
resume solving at any point.

Graph Editor
boujou 5.0 has a fully featured Graph Editor that
enables you to manipulate and adjust solve data
directly. You can edit data on a frame-by-frame
basis or over a range, interpolating, smoothing,
changing values, copying, pasting, and deleting
data as necessary.

Getting Started
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You can then use the edited data in subsequent
boujou solves.

Reference Frames/Sequences
Improve the accuracy of automated solves
You can now import one or more reference
frames or sequences to your main sequence.
This enables you to:
• Add parallax information.
• Create genuine 3D structure for nodal pan
sequences where there is no 3D information
in the sequence at all.
This new feature is particularly useful for shots
with low parallax but can improve the accuracy
of camera solving for many different types of
sequences.
Because you can now import more than one
sequence into your projects, you can choose
either to create a new camera for each sequence
or to use an existing camera.
When you import more than one sequence, you
can choose the sequence on which to perform
common tasks such as feature tracking, camera
solving, and importing an image-based mask.
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Target Tracker

Labeling Tracks

Faster target tracking

You can now easily identify the target tracks and
locators you have added, as well as all feature
tracks and 3D points.

Target tracking is now much faster, particularly
in sequences involving a large search area.

Single key target tracking
You now need to place target tracks in only a
single keyframe in one place in a sequence.
boujou then tracks the pattern you have specified
for the rest of the shot.
If you need to improve the accuracy of the
tracking, you can add target tracks in further
keyframes as necessary.

Multiple simultaneous target tracking
You can place more than one set of target tracks
before boujou begins the tracking process and
then track them all at the same time.

Advanced Solve Adjust
boujou’s solve adjust function has been extended
to allow locking of individual channels of translation
data and the locking of all rotation channels.
You can also run a solve adjust and affect only the
cameras and not the 3D structure. You can do this
over a selected range of frames rather than the
entire solve.

For each target track and locator you add, boujou
displays a text label that gives the name and type
of track. You can display the names of automated
feature tracks in the 2D image window and those
of survey points, predictions, target tracks, and
locators in the 3D view. You can choose to display
all or only selected track labels.
You can rename the labels to make them even
more easily identifiable.

New Instant Zoom Tool
The Instant Zoom tool lets you display a zoomedin view in the Image window at the press of a key.
The Image window display is centered wherever
you click the mouse in the Zoom Tool pane.
In this pane you can also set the zoom factor and
other zoom parameters.
Instant Zoom is particularly useful when you need
precise control over the position of elements in
the Image window, for example when you are
setting target tracks or locators.
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Software Licensing
To enable faster delivery and better software
management for system administrators,
boujou now uses the SafeNet Sentinel software
licensing system.
For details, see Sentinel RMS Development
Kit System Administrator’s Help, which ships
with boujou. For information about how to find
and read this file, see the instructions for your
platform in Chapter 2 Installation and Licensing
Information on page 15.
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This chapter lists the equipment you need to run
boujou and provides instructions for installing and
licensing the software in your chosen environment.
It covers the following topics:
System Prerequisites
Installation Preparations on page 16
Installation and Licensing Instructions on page 16
System Prerequisites
We recommend the following minimum computer
specification for boujou 5.0 to run successfully:
• Windows
XP SP3
Vista SP1
• Intel Macintosh
10.4 Tiger
10.5 Leopard
• Linux
Red Hat Enterprise 4.X +
Centos 4.X +
Fedora Core 5, 8, and 11

• At least 1 GB of RAM.
• At least a 1 GHz processor (or equivalent).
The processor must support SSE2
instructions. The majority of newer
processors do—however, Intel Pentium III
and some older AMD processors do not.
The tracking software is currently not multithreaded, so you will not see any significant
improvement in performance on a multiprocessor machine.
• An OpenGL graphics card.
• A two-button mouse.
• Approximately 90 MB of disk space for the
application and associated files.
• 24-bit color display.
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Installation Preparations
You need the following to install and run boujou:
• Administrative privileges to install the software
and reboot your PC.
• The installation disc or downloaded installer.
• License code.

Installation and
Licensing Instructions
The following sections provide instructions
for installing and licensing boujou in the three
supported environments:
• Installing and Licensing on Windows
• Installing and Licensing on Linux on page 18
• Installing and Licensing on OS X on page 19
Important. Some details of the installation
process may have changed slightly since this
book was printed. For up-to-date information,
see the readme file that came with your software.
If you have any problems during installation,
contact Vicon support (for details, see Chapter 5
Support Resources).
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Installing and Licensing
on Windows
You can install the software in any of the
Microsoft Windows environments listed in
System Prerequisites on page 15.
Important. If you have a network license, you
must set up a PC as a license server. You must
do this even if you intend to run boujou from the
computer that has the license installed. To do
this you must install the license server software.
This is presented as an option during installation.
To install and license boujou on Windows:
1. Insert the installation disc or double-click
the boujou 5.0 installation program icon. The
installation should start automatically. If it does
not, run boujou 5.0 on the installation disc.  
2. A typical installation will not include the license
server or licensing tools. If you are installing
a network license you will need to install the
license server and, optionally, the licensing
tools. You may want to install the licensing tools
even if you are running a node locked license.
If you want to install the license server or the
licensing tools, double-click the appropriate
installation program icon.  
3. Follow the instructions on each wizard page,
completing the required details.  
4. Restart your PC if prompted.
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To license boujou on a Windows system:
boujou licenses are locked to the Disk ID and
the Ethernet address of the machine on which
the licenses are to be installed. You will need
to generate a locking code for this machine.
To do this:
1. Do one of the following:
• Click Start > All Programs > Vicon >
Licensing > Request License
or
• Run <root directory>:\Program Files\Vicon
Licensing\wechoid.exe
Make sure that you have Disk ID and Ethernet
ID check boxes selected. This is very important.
The Selector field at the bottom of the
wechoid.exe window should read 0x14.
2. Copy the locking code from the Code field in
this window and return it to Vicon.
You should receive an email giving you details
for generating this locking code and where to
send it. If you do not receive this email, contact
Vicon support (for details, see Chapter 5
Support Resources). Vicon will supply you with
a license file (lservrc) by return email.
3. After you receive your license file, your next
step depends on your license type:
• If you have a node-locked license, copy the
license file into the root of your installation, in
the same directory as the boujou executable.

or
• If you have a network license:
• Click Start > All Programs > Vicon >
Licensing >License Manager
or
• Run <root directory>:\Program Files\
Vicon\Licensing\WlmAdmin.exe.
All of the available license servers are listed
on the left side.
Right-click the server onto which you wish to
install the license and choose Add Feature >
From a File > To Server and its File.
The licenses appear under the server name
on the left side of the Wechoid.exe window.
For further details of the Sentinel licensing
system, its advanced functionality, and the
licensing utilities that ship with boujou, see
the System Administrator’s Help.
To read the System Administrator’s Help:
Do one of the following:
• Click Start > All Programs > Vicon > Licensing >
Licensing Help
or
• In a browser, go to the directory:
<root directory>:\Program Files\Vicon
Licensing\ SysAdminHelp
Open index.html.
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Installing and Licensing on Linux
You can install boujou in any of the Linux
environments listed in System Prerequisites
on page 15. You can either:
• Use the supplied installation script.
or
• Copy the required files.
Please consult your System Administrator before
attempting to install boujou under Linux.
Important. If you have a network license, you
must set up a PC as a license server. You must
do this even if you intend to run boujou from the
computer that has the license installed.
To install boujou on Linux using the
installation script:
1. In a shell, type:
sh boujou_install.sh
2. At the prompt, specify the installation directory.
The default location for installation is /usr/local
You must have root privileges to install here;
otherwise, you will be prompted to supply an
alternative location:
• If you install the software as root, you can run
boujou 5.0 by typing the following command
in a shell:
boujou_5_0
or
• If you install the software as an unprivileged
user, you must set up your path to be able to
run boujou from any directory.

Getting Started
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To do this for the bash shell, add the following
line to your .bashrc or .bash_profile file:
export PATH=${PATH}:<boujou
installation_directory>/bin
To do this for the tcsh or csh shell, add the
following line to your .tcshrc or .cshrc file:
setenv PATH ${PATH}:<boujou
installation_directory>/bin
To install boujou on Linux without using the
installation script:
1. From the Linux/bin directory on the installation
disc, copy the two files required to run
boujou: boujou and boujou.dat to /usr/local
boujou_5_0_/bin
2. Ensure that both files have executable
permissions.
To license boujou on a Linux system:
1. From the installation package, copy the
licensing directory to the location of your
choice. This directory contains a range of
licensing utilities.
2. boujou licenses are locked to the Disk ID and
the Ethernet address of the machine on which
the licenses are to be installed. You must
generate a locking code for this machine. To do
this, from the licensing directory run echoid.
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3. Copy the locking code from the Console and
return it to Vicon.
You should receive an email giving you details for
generating this locking code and where to send
it. Contact Vicon support if you do not receive
this email (for details, see Chapter 5 Support
Resources). Vicon will supply you with a license
file (lservrc) by return email.
4. After you have received your license file, your
next step depends on your license type:
• If you have a node-locked license, copy the
license file into the root of your installation,
in the same directory as the boujou executable.
or
• If you have a network license, from the
licensing directory, install and start the
license server software, lserv.
Important. To start the license server, you
must be logged in as root. You must then
install your license. To do this, from the
licensing directory run:
lslic -F filename
where filename is the license file provided
by Vicon.
For further details of the Sentinel licensing
system, its advanced functionality, and the
licensing utilities that ship with boujou, see
the System Administrator’s Help.

To read the System Administrator’s Help:
1. In a browser, go to the directory:
licensing/SysAdminHelp
2. Open index.html

Installing and Licensing on OS X
You can install boujou 5.0 in any of the OS X
environments listed in System Prerequisites
on page 15.
Important. If you have a network license, you
will need to set up a computer as a license server.
You will need to do this even if you are running
boujou 5.0 from the computer that has the license
installed. To do this you will need to install the
license server software. This is presented as an
option during installation.
To install and license boujou on OS X:
1. Ensure that you are logged on to your computer
as a user with Administrative rights.
2. Insert the installation disc into your disc
drive or double-click the installation package
icon and run the boujou installation program
boujou_5_0.pkg.
Important. If boujou tells you that you have a
negative amount of RAM in the image cache,
set the amount manually in Edit > Preferences
> Miscellaneous > Total physical memory.
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To license boujou on an OS X system:
1. boujou licenses are locked to the Disk ID
and the Ethernet address of the machine on
which the licenses are to be installed. You
must generate a locking code for this machine.
To do this, run /Applications/boujou5.0
licensing/echoid.
2. Copy the locking code from the Console and
return it to Vicon.
You should receive an email giving you details
for generating this locking code and where
to send it. Contact Vicon support if you do not
receive this email (for details, see Chapter 5
Support Resources). Vicon will supply you with
a license file (lservrc) by return email.
3. After you have received your license file, your
next step depends on your license type:
• If you have a node-locked license, copy the
license file into the root of your installation,
in the same directory as the boujou executable.
or
• If you have a network license, from the
licensing directory run:
lslic -F filename
where filename is the license file provided
by Vicon.
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For further details of the Sentinel licensing
system, its advanced functionality, and the
licensing utilities which ship with boujou,
see the System Administrator’s Help.
To read the System Administrator’s Help:
1. In a browser, go to the directory:
licensing/SysAdminHelp
2. Open index.html
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This chapter shows you the basic
workflow for camera tracking
with boujou.
Important. In this chapter, the descriptions of the
locations of the various elements of boujou refer
to their default locations.
Before starting the tutorial on page 24:
1. Make sure the required shortcut buttons are
present in your Toolbox. For information on how
to do this, see Preparing the Toolbox.
2. Copy the sample files, tutorial1_cottage.[###].
jpg, to your hard disk drive. You can obtain
these files from either the installation disc
(under Tutorials\Tutorial_1\tutorial_1_source_
images), or the Vicon Web site (for details, see
Chapter 5 Support Resources).

Preparing the Toolbox
The Toolbox contains shortcut buttons that enable
you to access commonly used commands quickly
and easily.
To display the Toolbox:
In the left sidebar, click the Toolbox tab button to
make the Toolbox active. Make sure the Toolbox
contains the following buttons:

• Import Sequence
• Track Features
• Camera Solve
• Export Camera
• Preferences

If any of these buttons is missing, add it using
the following procedure.
To add a shortcut button to the Toolbox:
1. Right-click in an empty area of the Toolbox and
from the displayed list of available shortcuts,
point to the required type of shortcut and then
click the shortcut name.
2. Repeat this until you have added all of the
required shortcuts to the Toolbox.

24

Basic Tracking Tutorial
This tutorial demonstrates the basic tracking
workflow in boujou.
It includes the following lessons in the order in
which the workflow steps need to be performed:
1. Importing an Image Sequence
2. Tracking the 2D Features on page 26
3. Solving the Camera (Calculating the
camera motion) on page 27
4. Exporting the Camera on page 28
Tip. For instructions on using advanced features,
see the boujou Tutorials book.

Importing an Image Sequence
The first stage of the camera-tracking process
is to load the image sequence that you want to
track. boujou then finds features in these images,
analyzes how they move, and works out the
motion of the camera and the 3D structure of
the scene.
In this lesson, you will import a sample image
sequence supplied with boujou and verify that
boujou has used the correct camera settings.

Getting Started
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To import an image sequence into boujou:
1. Click the Toolbox tab to make the Toolbox
active. In the default layout, this is located in
the left sidebar.
2. In the Toolbox, click the Import Sequence
button.
Two dialog boxes are displayed, with the Import
Sequence dialog box, in which you can browse
to find the required file, on top.

25

boujou 5.0
The first choice for professional matchmovers

3. In the Import Sequence dialog box, browse
for the image sequence tutorial1_cottage.[001100].jpg, click the name of the first image in the
sequence, and then click the Open button.

The Taskview pane is displayed.

4. In the Image Sequence dialog box, leave all the
settings at their default values and click OK.

6. In the Taskview pane, expand Cameras and
then double-click Camera 1.

5. To check that boujou has used the correct
camera settings, click the Taskview tab (in the
default layout, this is located in the left sidebar).
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The Camera Properties dialog box is displayed.
Note that boujou has correctly chosen a PAL
camera type, based on the image resolution.
You do not need to change any of the settings,
so click Close.

Getting Started
Getting Started with boujou

The Feature Tracking Properties dialog box
is displayed.

7. Play the sequence using the Play Controls at
the bottom of the screen. The first play-through
may be slower than subsequent play-throughs
as boujou loads the images into cache.

Tracking the 2D Features
In this lesson, you will learn how to track features
for the image sequence you imported in the
previous lesson.
To track features:
1. Click the Toolbox tab, then click the
Track Features button.

2. Note that Sequence 1 is selected in the
Sequence field. If you had imported another
sequence, you would be able to select it from
this list. Leave all the settings at their default
values and click Start to begin feature tracking.
Feature tracking begins from frame 0 and
progress is displayed in the Status bar just
below the main Image window.
Feature tracking in boujou is not merely image
pattern-matching, and does not have to be

boujou 5.0
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perfect for each feature, so do not worry if some
matches look wrong.
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The Advanced Camera Solve Properties dialog
box is displayed.

At this point you could select the Solve Camera
check box, in the right side of the status bar, to
make boujou start camera solving as soon as it
has finished tracking the features.

For this tutorial, however, we will perform
camera solving as a separate process.
3. When feature tracking is complete, play the
sequence through to examine the feature tracks.

Solving the Camera
(Calculating the Camera Motion)
In this lesson, you will learn how to configure
boujou to calculate the camera position,
orientation, and focal length, based on the feature
tracks you generated in the previous lesson.
To solve the camera:
1. Click the Toolbox tab, then click the Camera
Solve button.

2. Note that Sequence 1 is selected in the
Sequence field. Leave all the settings at their
default values and click Start to begin the
camera solving process.
boujou calculates the camera position, orientation,
and focal length at each frame. Camera
tracking progress is displayed in the Status bar.
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When camera tracking is complete, yellow and
cyan dots appear in the Image window. These
dots are called predictions and they show the
3D positions of the 2D features that were used
to calculate the camera:
• The yellow 3D predictions are for 2D features
visible in the current frame.
• The cyan predictions are for features that
were not found in the current frame, but
that are visible in some other part of the
sequence.
Predictions exist for the entire length of
the sequence, even when the features they
represent are out of shot. If you play through
the sequence, the predictions should look as
though they are stuck to features in the images.
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Exporting the Camera
In this lesson, you will learn how to export camera
data from boujou in a format that can be used by
supported third-party animation software.
To export camera data from boujou:
1. In the Toolbox, click the Export Camera button.

The Export Camera dialog box is displayed.

3. Save the project when camera solving is
complete. (It is always a good idea to save your
work regularly although by default boujou
automatically saves your project after featuretracking or camera-solving. You can turn
autosaving off and on and change the default
location of autosaved files in Edit > Preferences
> Directories.)
Tip. If at any time you need to restart boujou and
reopen your saved project, information you have
added, such as predictions, may not be visible. To
see them, in the Image window, right-click and
then click the required option (in this case,
Predictions), from the menu.

2. In the Filename field enter (or navigate using
the Browse button) the location at which you
wish to save the exported file.

boujou 5.0
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Note that Sequence 1 is selected in the Image
Sequence field.
3. From the Export Type drop-down menu,
select your preferred export format and then
click Save.
The camera animation and all of the 3D
predictions are exported. For more information
about the various export formats supported by
boujou, see Export to an Animation Package in
the boujou Reference Guide.
Tip. You can specify the default export format
in the user preferences. In the Toolbox, click
the Preferences button, expand Camera Export,
then expand General, click Default Format
and in the drop-down menu, select your
chosen format.

This completes the basic workflow tutorial. You
have performed the four fundamental tasks of
importing, feature tracking, camera solving, and
exporting, and learned the essential concepts
underlying automated camera tracking in boujou.
For more information about match moving with
boujou see the boujou Tutorials book.
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This chapter provides guidance on how to plan your
shots to get the best results from boujou and how to
track more complex camera moves:
Planning and Preparation Tips
Feature Tracks Tips on page 36
Camera Solving Tips on page 38
Important. If you have additional questions or require further assistance, log on to
our boujou Online Support System, at www.vicon.com/support, or contact Support
at boujousupport@vicon.com. For details, see Chapter 5 Support Resources.

Planning and
Preparation Tips
This section provides guidance on the
considerations you should keep in mind
when planning your shots to get the best
results from boujou:
• Shot Planning and Preparation
• Bluescreen and Greenscreen Shots on page 34
• AVI Codecs on page 34
• Shots that Feature Many T-Junctions
on page 35

Shot Planning and Preparation
If you are shooting your own footage, or if
you are a VFX supervisor and have an influence
over how a scene is shot, then you should be
aware of what boujou can track well and what
could cause problems.

The following sections offer tips on planning
and preparing shots in boujou:
• Parallax
• 3D Depth on page 33
• Motion Blur on page 33
• Moving Objects on page 33
• Large Foreground Objects Obscuring
Background Objects on page 34
Parallax
For boujou to solve well, the shot should
have plenty of parallax. If there is no parallax,
boujou cannot calculate any depth information
from the scene. If we look at an object from
two separate points in space, we are able to
perceive information about its depth. If we look
at the object from a single, fixed point in space,
we do not get any depth information.
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If we move our viewpoint sideways, the parallax
effect provides us with a sense of where
the object is in relation to its environment.
The following diagrams help explain this
concept further.
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The following diagram shows the effect of
panning the camera a few degrees to the left.
It still can’t tell that there is a second cylinder
behind the first.

The following diagram shows two objects in
the camera’s view.

On the left side of the following figure, we see
that the camera is lined up in front of the two
cylinders, so it can’t see that there is a second
cylinder behind the first, as shown on the right
side of the figure.

The following diagram shows the effect of panning
the camera left and trucking it to the right. The
camera’s center is now at a different position in
3D space and it can see the second cylinder.
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3D Depth
The scene should have 3D depth. Depth is the
range of acceptable focus which extends both in
front of and behind the principal subject of
a scene. Depth of a scene is controllable to
some extent through the selection of lens focal
length and lens aperture. Shots without any
foreground structure reduce the amount of 3D
depth information available for boujou 5.0’s
calculations, resulting in an inaccurate 3D
structure. You should make sure that you do
not have a sequence where all of the trackable
features lie on a plane.
Motion Blur
Motion blur conceals features and makes them
less distinct. Motion blur is the natural occurrence
of blur in an image as the subject moves through
the frame during exposure. The amount of motion
blur increases as the speed of the subject or the
exposure time increases. Sudden variations in
motion blur can cause boujou’s feature tracking to
fail, and so it is something to be avoided wherever
possible. Shooting with a high shutter speed
reduces the amount of motion blur in your shot
(and you can always add it in again at the end as
a 2D effect). You may want to consider using one
of the commercially available tools for removing
motion blur.
To help to track through moderate amounts of
motion blur, in the Feature Tracking Properties
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dialog box, click Advanced and then select the
Large option in the Feature Scale area.
Moving Objects
If a large amount of the image area is covered by
moving objects (crowds of people, for example),
boujou may get confused about what it should
be tracking. Creating a mask enables you to tell
boujou what to track and what to ignore.
boujou is optimized for tracking the whole scene
and not for tracking moving objects in a scene.
However, if the object is large enough (about 20%
of the total image area) then you can get a good
track by using a mask to isolate the moving object
and hide the background.
boujou is not suitable for face tracking, but you
can track the overall movement of the head if
the actor is wearing a rigid object on their head
(a hat covered in newspaper, for example).
For the same reasons boujou cannot track
fire, water, or smoke. These are all non-rigid
bodies that move in a random way, and they
generate feature tracks that move in many
different directions. Leaves or grass moving in
the wind can also cause problems because of the
inconsistent motion of the feature tracks.
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Large Foreground Objects
Obscuring Background Objects
Avoid shots where a large foreground object
obscures background objects. Pillars, telegraph
poles, etc. can hide background features, making
a shot more difficult to track and reducing the
accuracy of the 3D structure. Joining tracks or
using the Non-consecutive feature tracker can
help to improve the accuracy of shots like these.
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The following marker shape was developed by
Joerg Liebold at Psyop, New York, and gives good
results over a wide range of conditions for both
automatic and target tracks.

Bluescreen and Greenscreen Shots
Bluescreen and greenscreen studios can cause
problems for boujou because of the inherent lack
of trackable features. The tracking markers used
in these environments are often all placed on the
same plane, and this causes problems because of
the mathematical ambiguity of the 3D structure.
Place tracking markers on as many surfaces
as possible in order to maximize the amount
of 3D depth information. They don’t need to be
regularly spaced, but try to put as many as you
can in any area that isn’t going to be obscured
by the actors. Conventional circular markers do
not automatically track well unless they are very
small. Crosses of white tape are better, but they
can cause a lot of track jumping if your search
distance is too high. The target tracker can
track both of these marker shapes without any
problems, but it is a more time-consuming way of
generating tracks.

boujou can do a much better job if your
bluescreen studio is full of items and objects.
For example, if you have boxes, tables, etc. around
the edges of the action, you are giving boujou a
lot of vital information about the 3D structure
of the shot. Paint your items blue if you have to
(although wrapping a box in newspaper will give
you an excellent source of tracking points and
3D information) but try not to leave large areas of
flat blue or green in the shot if you can avoid it.

AVI Codecs
The Windows version of boujou can import any
AVI file as long as you have the appropriate codec
installed on your computer. Some compressors
can cause feature tracking to run very slowly
because boujou has difficulty extracting the
individual frames from the AVI. MPEG-4 and DivX
encoding seem to cause the biggest slowdown in
feature tracking.

35

boujou 5.0
The first choice for professional matchmovers

Shots that Feature Many
T-Junctions

between the verticals of the cylinder and the
horizontals of the cube. These intersections
form T-junctions.

T-junctions are features that get tracked
by boujou when a foreground object and a
background object combine in a particular image.
They are not true 3D features, so they can have
an adverse effect on the accuracy of the camera
solve. Deleting the T-junction tracks, or using
masks to hide the objects that are causing them,
improves the camera solving quality.
The following diagrams help explain this
concept further.
The following diagram shows a camera looking
at a cylinder in front of a cube.

The following diagram shows the features that
would be detected in this frame at the corners
of the cube and at the apparent intersections

In following diagram, the camera has moved up
and right. This movement would be accurately
calculated if just the features at the corners of
the cube were used. However, the T-junctions
have moved very little since the first frame and
their contribution would result in an inaccurate
solve. In reality there would be far more features
tracked in this scene; the T-junctions would be
discarded because their motion is inconsistent
with the rest of the tracks.
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Feature Tracks Tips
This section provides guidance on improving the
quality of automatic feature tracking in boujou.

Improving the Quality of the
Feature Tracks
There are several reasons why boujou can have
difficulty in feature tracking certain shots. Flash
frames, motion blur, film grain, rain, smoke, or
fog can lead to a lack of trackable detail in one
or more frames of a sequence.
If boujou cannot find any features at all in up to
three consecutive frames, it jumps over the gap
and continues tracking. If there are no features
in four or more consecutive frames, the feature
tracking is split, and two separate cameras
are calculated. If you keep the Console Pane
open during feature tracking, it will tell you if
any frames could not be tracked or if any other
problems occurred.
The Feature Tracking info window (in Taskview,
expand Feature tracking then double-click
Feature Tracking) gives you more details about
how many tracks were found and how long they
were. The more long feature tracks you have, then
the more accurate your camera solve will be.
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If there are not enough feature tracks over part
of a sequence, boujou cannot calculate a single
camera for that sequence. Two or more camera
solution fragments will be calculated and this
makes the task of adding CG objects in your 3D
animation software more complicated. To avoid
this, you should try to increase the number of
feature tracks over the critical sections of your
shot. A minimum of around 10 tracks are needed
for boujou to be able to calculate a camera.
Changing the settings in the Advanced section of
the Feature Tracking Properties dialog box can
have a big effect on the quality of the tracks. Try
using large scale features, adjusting the sensitivity,
or not tracking one of the color channels.
The following sections offer tips on improving
the quality of feature tracks in boujou:
• Gold Tracks
• Manual Locators on page 37
• Target Tracks on page 37
• Search Window on page 37
• Camera Move and Type on page 37
Gold Tracks
A good way of increasing the number of feature
tracks is to make some of the good tracks gold
(right click a track and select gold from the menu)
and then do the feature tracking again. Each time
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you do this, more feature tracks are created (the
gold tracks are being used as a guide for the
automatic tracking). You can check the number
of feature tracks that have been created in each
tracking pass by looking at the Feature Tracking
Info window. Keep repeating this process until
the number of feature tracks does not increase
significantly and then try camera solving.
Manual Locators
Add a manual locator over the problem frames
before feature tracking. A manual locator is
like a feature track that you create by eye, one
frame at a time. It is defined as a gold track by
default and can help to guide boujou’s automatic
feature tracker through the problem areas.
Manual locators are particularly useful if your
sequence contains several frames of motion blur.
An animator will probably be able to judge how a
feature should be moving during motion blurred
frames quite accurately, and so by adding some
manual locator tracks the user can help boujou’s
automatic tracker.
When adding locators, aim to have at least three
locator keyframes on the same frame and avoid
creating single locator keyframes. Add locator
keyframes on solve keyframes only.
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Target Tracks
Target tracks can also be used to guide the
automatic tracker. Target tracking is a semiautomatic process and can track features that
would be ignored by the automatic tracker circular bluescreen markers, for example. An
entire shot could be tracked using the Target tracker.
Search Window
If your camera move is very fast then you should
increase the value of the maximum search
distance in the Advanced section of the Feature
Tracking Properties dialog box. The search
distance controls the distance that boujou looks
from frame to frame for a feature that it thinks
is part of the track it is building. The value set is
the ratio of window size to image size in a given
direction, expressed as a percentage. The default
range is 1% to 20% and the search distance
varies adaptively between these limits. If your
shot is fast-moving or contains a whip-pan, then
increasing the maximum value of search distance
can help to prevent the tracks from breaking and
becoming fragmented.
Camera Move and Type
Make sure you have set the camera move type to
the appropriate setting before you begin feature
tracking. If the camera was free to rotate and
translate in the X, Y, and Z directions, then the
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move type is free move. If the camera was only
able to pan and tilt (rotate in X, Y, and Z, as though
mounted on a tripod), then the move type is nodal
pan. The nodal pan move is a special case because
the shot will have no parallax at all, making it
impossible to determine the true 3D structure of
the scene. When boujou tracks a nodal pan shot,
all of the calculated 3D predictions are placed on
the surface of a sphere (see Tracking a Nodal Pan
in the boujou Tutorials book).
A scene doesn’t have to be shot with a tripodmounted camera to be solved as a nodal pan.
If the objects in the scene are far enough away,
then a hand-held shot where the camera operator
stands still but rotates from the waist can be
solved as a nodal pan.

Camera Solving Tips
This section describes problems you might
encounter with camera solving in boujou
and suggests ways in which you can avoid or
correct them:
• Improving the Quality of Camera Solving
• Scene Rendering in 3D Animation Software
on page 43
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Improving the Quality of
Camera Solving
Camera solving should rarely fail completely.
It should always return a result of some kind,
but this result may not be valid for the entire
sequence, and it may not be of acceptable quality
for exporting to your 3D animation software.
Getting a better set of feature tracks is usually
the best way of dealing with a very bad camera
solving result, but for less serious problems try
adding locators in problem areas and then doing
an Adjust Only camera solve. The advantage of
this technique is that it gives fast feedback.
If boujou is unable to calculate a camera for the
entire sequence, it tries to do as much as it can.
This will give you either a single camera solve
for only part of the sequence, or several solve
fragments. These fragments cannot be joined
together within boujou but they can be reused
once you have improved the problem areas.
Localized motion blur or large, occluding objects
can cause the camera solving to be split into
fragments. The techniques discussed in the
section Improving the Quality of the Feature
Tracks on page 36 will help you to find enough
feature tracks in problem areas to prevent the
camera solve from splitting.
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The following sections explain a number of ways
that camera solving can produce inaccurate
results and offer tips on improving the quality
of camera solving in boujou:
• Drift
• Wobble
• Broken Camera Path on page 40
• Bad Structure on page 41
• Improving Results with the Graph Editor on
page 42
• Other Camera Solve Problems on page 42
Drift
Symptoms:
• An augmenting object appears to drift away
from its reference feature during a long
sequence.
• A circular dolly move fails to match up at the
beginning and the end.
• Predictions for an object that leaves the image
are in the wrong place when the object returns.
• Certain features in the image are omitted after
camera solving.
Joining feature tracks before camera solving
gives boujou more information about the position
of a feature in 3D space. This helps to reduce
the amount of drift caused when a feature is
temporarily hidden by an occluding object or goes
out of frame for a time. Non-consecutive feature
tracking can automatically join a large number
of tracks at one time.
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Make some of the longest, most accurate tracks
gold and then feature track again. The automatic
feature tracker tries to find more tracks like the
gold ones, resulting in a better set of tracks being
given to the camera solver. If you make any tracks
gold, make sure that the track is good for its
whole duration: not all of the tracks are visible at
any one time unless you change the default track
visibility settings.
A Solve Adjust after initial camera solving can
bring about significant improvements in the
quality of the camera path and the accuracy of the
3D structure, especially if you have added some
locators after camera solving.
Sometimes drift is caused by lens distortion.
Radial distortion can skew the 3D structure of the
shot, thus preventing the beginning and end of
a circular dolly from matching up, or making a
CG set extension appear to drift away from the
real structure.
Wobble
Symptoms:
• An augmenting object appears to jump over a
short period.
• The camera path looks noisy when viewed in
the 3D view.
• Error spikes appear in the residual values
given in the Camera Solve Summary window.
• High error vectors can be seen when the Errors
overlay is on.
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Try adjusting the camera path using the graph editor.
A Solve Adjust can sometimes fix these problems.
If not, add locators or target tracks to the
problem area, feature track again over that
range, and then camera solve. This helps to show
boujou what it should be tracking and what it
should be ignoring.
Try deleting any feature tracks associated with
moving objects or T-junctions and camera solve
again, or hide any moving objects with a mask
and feature track.
Check with the camera operator to see if there
were any changes in focal length when the
sequence was being shot. If you do not tell
boujou that the shot has variable focal length then
it assumes that the focal length was constant and
any changes are interpreted as a dolly, resulting
in an inaccurate camera path and poor structure.
If the shot starts or finishes with a static camera,
boujou may calculate a noisy camera path. Ignore
the static frames and track just the section where
the camera is moving.
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Broken Camera Path
Symptom:
• A radical change in direction of the camera path
when viewed in the 3D view which results in two
sets of predictions for a single camera path.
This is one of the most serious types of camera
solving failure. It can be caused by a combination
of factors, particularly if two or more sections
of the shot suggest radically different camera
solutions (this can happen if your image sequence
has a lot of lens distortion).
boujou enables you to use a range of tools
and techniques to fix broken camera paths.
These include:
• Correcting for lens distortion
• Gold tracks
• Target tracks
• Masks
• Advanced solve tools
• Model tools
• Copying and pasting views then optimizing
the view
• Interpolating or solving from existing
cameras (including using the graph editor).
You can also track the sequence in shorter
subsections and interpolate between them
using the graph editor and advanced solve tools.
When tracking in subsections you can use focal
length values from a good section as a constraint
to either fix or initialize subsequent sections.
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Details of these tools can be found in the
accompanying boujou documentation.
Important. Tim Dobbert’s book, Matchmoving:
the Invisible Art of Camera Tracking (Sybex, 2005,
ISBN 0-7821-4403-9) contains a very useful
chapter on how to connect two partial camera
tracks in a 3D animation package.
Bad Structure
Symptoms:
• 3D structure appears to be inside out.
• The camera moves in the wrong direction.
• Strange structural anomalies.
• Very inaccurate 3D depth.
You can use Regenerate Structure and Filter
Structure (3D Tasks > Solve Tools) to provide a
denser, more accurate set of 3D prediction points.
Inverted structures are usually caused by there
being more background tracks than foreground
tracks at the start of a shot. To cure this problem,
make some foreground tracks gold before
tracking the camera.
Use a mask to hide any parts of the image that
may cause confusing tracks. For example:
T-junctions, specular highlights on reflective
objects, text overlays on the original images, or
moving objects.
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If your 3D predictions have very inaccurate depth,
check to see if the shot was a nodal pan. A nodal
pan shot has no parallax, and so boujou is unable
to calculate the distance of points from the
camera because the features in the scene do
not move relative to one another. Solving a nodal
pan shot as a free move gives you a confusing 3D
structure (see tutorial Tracking a Nodal Pan in
the boujou Tutorials book).
Shots where there is very little foreground
structure can also result in inaccurate 3D depth.
An example of this would be a shot taken out of
the side of a vehicle moving quickly along a desert
road. All of the foreground will be hidden by
motion blur and the distant mountains will have
insufficient parallax to give a good 3D structure.
An accurate camera solve will probably not be
possible for a shot like this unless there is so little
parallax that you can solve it as a nodal pan. It
can sometimes be helpful to constrain the distant
predictions to a plane using planar constraints.
Lens distortion can result in structural anomalies
such as flat surfaces appearing curved and 90
degree angles becoming obtuse. boujou enables
you to correct lens distortion, and this is essential
if you are working on a set extension project.
Changing focal length values and constraints can
also can also affect the 3D structure. Try altering
these constraints and the values to which they are
set by a few millimeters and observe the effects.
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If all of the solvable features in a shot lie on a flat
plane, the 3D structure becomes mathematically
ambiguous. The camera solve and structure
calculated by boujou for a shot like this are likely
to be noisy and inaccurate. This is a problem that
can sometimes occur with bluescreen shots.
Using target tracks can help to improve the
tracking quality. Planar constraints may also help.
Improving Results with the Graph Editor
boujou’s graph editor can help you to overcome
many of the problems described above. By
examining the curves in the graph editor you can
get a clearer picture of the problem areas of a
shot. For example, there may be a short noisy
section on one or more of the motion curves, or
even a single frame that 'spikes' out of alignment
and is clearly inaccurate.
You can edit these problem regions in the graph
editor and use the adjusted data to help boujou
improve its results. For more information on
using the graph editor, see Using the Graph
Editor in the boujou Tutorials book.
Other Camera Solve Problems
More specific problems include camera moves
that change from free move to nodal pan, shots
in which the camera stops moving, and a free
move with variable focal length.
If the move type changes from nodal pan to
free move (or vice versa) during a shot, break
the image sequence into sections, and import
and solve them separately.
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Your approach will vary depending on how much
information you have about the focal length:
If the focal length is

Then

Constant and known
throughout the shot

Track each section
with the same value
by setting the focal
length constraints
appropriately. To set
focal length constraints,
open the Focal Length
dialog box (Setup >
Edit Focal Constraints).

Constant but unknown

Solve the free move
section then use the
focal length value
from this solve in
the pan section.

Varied across
the sections

Solve the free move
section then use a
variable initialized
constraint in the pan
section to find the start
or end focal length.

If the camera is stationary at the start or end of a
free move shot, ignore the stationary frames and
track only the moving section.
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Camera solving gives inaccurate results if any of
the input parameters are incorrect. Check that
the move type, the pixel aspect ratio, the focal
length, and the interlacing options have all been
set to the appropriate values.
Important. Tim Dobbert’s book, Matchmoving:
the Invisible Art of Camera Tracking (Sybex, 2005,
ISBN 0-7821-4403-9) contains a very useful
chapter on how to connect two partial camera
tracks in a 3D animation package.

Scene Rendering in 3D
Animation Software
Symptom:
• CG objects seem to wobble when rendered in
3D animation software
Even though your camera solve looks perfectly
matched in boujou, sometimes when you render
the scene in your 3D animation software the CG
elements will seem to wobble relative to the
background images. The most common cause of
this problem is that your camera animation frame
numbers do not correspond with the correct
image frame numbers. Check the frame number
of the first frame of the camera animation.
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Another common cause of this problem is that
the camera animation and the timeline have been
set to different frame rates in your 3D animation
software. Check your motion curve editor to
make sure that the camera keyframes line up
with the frames on the timeline. boujou defaults
to exporting the camera animation at 24 frames/
second unless you change the value in the Import
Sequence dialog box (Setup > Edit Sequence):
• If the wobble is constant throughout the
sequence, then it is caused by mismatched
frame numbers.
• If the wobble seems to get worse towards
the end of the sequence then it is caused by
mismatched frame rates.
This problem is most frequently reported by XSI
users. If you are an XSI user, then we strongly
recommend that you carefully read the section
Importing the Scene into Softimage XSI in the
chapter Export to an Animation Package in the
boujou Reference Guide.
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This chapter describes the resources
available to you to obtain support for
your use of boujou.
If you have a technical support query, go to
the Support page on the Vicon Web site:
www.vicon.com/support
Here, you can search through an extensive
list of FAQs, or you can Log a Case to submit
support requests to our technical support team.
All users with an up-to-date support contract
will have a log-in name and password for
full access to the Web site. If you have not yet
received your log-in details, please contact us
at boujousupport@vicon.com.
When reporting a bug, please try to supply as
much of the following information as possible:
• Company name
• A description of the bug with steps to
reproduce the problem
• boujou software version number
• Operating system
• Image size, format, and number of frames
• Example images or screen grabs
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